Tema laborator 1
Pregatire si instalare instrumente software

1 Materiale aditionale ce trebuie lectuarte
Nu sunt

2 Aflare detalii despre sistemul de operare.

Click dreapta pe Computer apoi selectati Properties:

= | =] 22

{ ? i t Bl Y » A ] / - |+ Seagrch Control Panel [
AN, | Control Panel Il Control Panel Items System | ¢|| Search Control Panel
File Edit Wwiew Tools Help

Systemn -

Control Panel Home
Manufacturer: Asus

) Device Manager Rating: 85} Windows Experience Index

= . L
% Remote settings Processor: Intel(R) Core(TM) i5-2500 CPU @ 3.30GHz / #

[ System protection 330 GHz
8.00 GB

In

'E‘;' Advanced system settings

System type: 64-bit Operating System

Pen and Touch:

o Pen or |cuch Input is available for this

Display
Asus support
Phone number: 1-888-678-3688
Support hours: Mon-Fri: 9:00am-6:00pm =
Website: Online support

See also
) Computer name, domain, and workgroup settings
Action Center

Windows Update Computer name: N-PC '&'Change settings
Performance Information and Full computer name: N-PC
Tools Computer description:

Warkaroup: MSHOME i

Va arata versiunea de sistemului de opeare.
Daca aveti Linux, stiti ce versiune aveti.

3 Instalare Java 1.8 JDK

1. Mergeti la: http://www.oracle.com/technetwork/java/javase/downloads/jdk8-

downloads-2133151.html

Acceptati ,,License agreement”-ul

3. Selectati versiunea de sistem de operare potrivita (in cazul de mai sus, Windows
X64) Nu este gresit sa selectati o versiune pe 32 de biti daca aveti sistem de
operare pe 64 biti. Invers insa, nu va merge.

4. Lansati installer-ul si urmati pasii.

N


http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html

4 Instalare mediu Eclipse

1. Mergeti la http://www.eclipse.org/
2. Click pe butonul portocaliu ,,Download”

= eclipse

\_A a

GETTING STARTED MEMBERS PROJECTS MORE~

3. Selectati al 2-lea produs:

= eclipse

GETTING STARTED MEMBERS PROJECTS MORE~

HOME / DOWNLOADS

Packages @ Developer Builds | )Java™ 8 Support

Eclipse Luna (4.4.1) Release fnr

Package Solutions

Eclipse IDE for Java EE Developers
ol Downloaded 153,330 Times

e Windows 32

igﬁ Tools for Java developers creating Java EE and Web Bit
applications, including a Java IDE, tools for Java EE, |PA, |SF. Windows 64

Mylyn... Bit

Ef%se IDE for Java Developers
| 76,149 Times .

y Downloaded 76,149 Times Windows 32

et The essential tools for any Java developer, including a Java Bit
IDE. a CVS client, Git dient, XML Editor, Mylyn, Maven Windows 64

integration... Bit

Descarcati conform sistemului de operare.

Dupa ce se descarca, deschideti arhiva (vezi la sfarsitul indrumatorului).

Copiati directorul eclipse din arhiva undeva pe HDD-ul local (ex: in C:\eclipse
sau D:\eclipse)

7. Intrati in noul director si faceti shortcut la eclipse.exe pe desktop: (Click dreapta
pe fisier, Copy, Click dreapta pe desktop si Paste shortcut)
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Deschideti Eclipse-ul
9. Confirmati locatia implicita pentru workspace (locul unde se vor salva toate
proiectele)


http://www.eclipse.org/

S Workspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

[y CHETCC:\ Users\vis oft\workspace|

[Use this as the default and do not ask again

A EBrowse...

Se deschide mediul Eclipse:

Welcome to the Eclipse IDE for Java

Developers
s % Overview m Tutorials
Get an overview of the features %  Go through tutorials

4
[

Samples

/\_ What's New

Try out the samples v Find out what is new

2 Java - Eclipse @EIQ

File Edit MNavigate Search Project Run Window Help

= @ welcome i fiy oA = 8

& g B
Workbench ’7

m

m

5 Instalare TestNG

1. Ineclipse, mergeti la Help->Eclipse Market Place




w

& Eclipse Marketplace

Eclipse Marketplace

0

Select solutions to install. Press Finish to proceed with installation.
Press the information button to see a detailed overview and a link to more information.

Search installed| , September 09/25
Find: IAII Markets '] IAII Categaries 'l Go

Featured

JRebel for Eclipse

m

Rebel Promoted - Is your Java EE development cycle rather mare like Continuous
Restart than Continuous Coding? Try coding without the need to restart
anything, even.. more info

by ZeroTurnaround, Commercial
J2EE eclipse java ee tools productivity

% 57 Installs: 121K (4,246 last month) Install

Vaadin Plugin for Eclipse

Promoted - ‘aadin is a powerful open source Ul library for creating rich web
wvaadin }= user interfaces. It is a Java EE compatible component library that makes it easy...
more info

by Vaadin Ltd, Apache 2.0
java J2EE web ria java ee

T34 Installs: 68.0K (3,918 last maonth) Install

Dresden OCL 3.3.0

. Dresden OCL provides a set of OCL tools that can be used to integrate OCL2.3
support into other Eclipse and stand-alone projects. Currently, Dresden OCL o

Marketplaces

=P X%

' -
(‘_?/' < Back Install Now = Finish

In casuta de Find scrieti testng si dati enter (sau click pe lupa)

Dati install pe TestNG for Eclipse

Dati Confirm, Accept si Finish. La Security Warning, dati OK, dupa care Yes la
restart mediu Eclipse.

6 Instalare Mockito

Mergeti la https://code.google.com/p/mockito si downloadati ultima versiune de
mockito, arhiva .zip (ex. mockito-1.9.5.zip)

Despachetati continutul undeva pe hard disk-ul local. Va trebuie in mod special
fisierul mockito-all-1.9.5.jar



https://code.google.com/p/mockito

7 Hello world

7.1 Crearea unui proiect nou

Acesti pasi ii veti face de fiecare data cand vreti sa creati un proiect nou

1. Selectati File -> New -> Java Project

( & Java - Eclipse
Edit Mavigate Search Project Run Window Help
New Alt+Shift+MN ¥ | (22 Java Project
Open File... i Project...
Close ctrl+w | @ Package
-~ Close all Ctrl+shift+w | @& Class
Save Ctrl+S g Interface
Enum
Save As...
Save Al ctrl+shift+s | & Annotation for
2. Se deschide New Java Project:
3. Populati campul cu numele proiectului
& New Java Project | I

Create a Java Project

Create a Java project in the workspace or in an external location.

~

e

Project name: HelloWorld

Use default location

Location: | C\Users\visoft\workspace_luna\Helloworld

JRE /7

Browse...

@ Use an execution environment JRE: [Ja\raSE-ly

0 Use a project specific JRE: jrel.8.0 20

() Use default JRE (currently 'jrel.8.0_207

Project layout

() Use project folder as root for sources and class files

@ Create separate folders for sources and class files

Working sets
[T] Add project to working sets

Configure JRES...

Configure default...

Working sets: elect.
® < Back Mext = l [ Finish ] l Cancel




4. Click Next
5. Adaugati un nou source folder numit test:

a. Faceti click pe Java source folder wizard ‘
& New Java Project (BRIl

Java Settings
Define the Java build settings. / .

® Source |Eb Projects | = Libraries | % Order and Export

B w | - nel B @
4| Helloworld|
b sre
~ Details
& Create new source folder: use this if you want to add a new source folder to your e
project.
& Link additional source: use this if you have a folder in the file system that should be |
used as additional source folder.
&2 Add project 'HelloWorld' to build path: Add the project to the build path if the

project is the root of packages and source files. Entries on the build path are visible
to the compiler and used for buildina.
[] Allow output folders for source folders

Default output folder:

Helloworld/bin

® Next > Finish | l Cancel

b. Scrieti test la Folder name



& New Source Folder E=EE

Source Folder —
Add a new source folder relative to 'Helloworld".

mame:

® < Back Mext = ] [ Finish ] ’ Cancel

c. si Finish.

6. Adaugati alte biblioteci necesare proiectului
a. Intrati pe tab-ul Libraries din fereastra New Java Project

b. Selectati Add external Jars
& Mew Java Project ==l

Java Settings —
Define the Java build settings. /

|4~
2 Source | = Projects| Ei Libraries |<}{P Order and Export|

JARs and class folders on the build path:

> = JRE System Library [JavaSE-1.8] l Add JARs...

-

/a Add External JARs...
l

Add Variable...

l Add Class Folder...

l
|
|
[ Add Library... |
|
J

lAdd External Class Folder..

Edit...

Remove

c. Navigati la locatia unde ati despachetat mockito si selectati mochito-all-
1.9.5jar



[ Source Projects | B Libraries | % order and Export
| |= | | |

JARs and class folders on the build path:

> |lms mockito-all-1.9.5.jar - DASTUDIymockito

» B JRE System Library [JavaSE-1.8]

d. Dati pe Finish

7. Inchideti fereastra Welcome, daca e deschisa.

£ Java - Edlipse /

File Edit Naw’gateéearch Project Run Window Help
5 @@ welcome 5

&

()

=]
]

Welcome to the Eclips
Developers

(Y Overview

Get an overview of the features [

Va apare structura proiectului nou creat, cu cele 2 foldere.

& lava - Eclipse

File Edit Source Refactor Mavigate Search Project R
i i SISO -G G
[% Package Explorer &2 B&|e ¥= 0O
4= Helloworld

&8 src
[ test

> = JRE System Library [JavaSE-1.8]
> =) Referenced Libraries

k&

7.2 Crearea unei clase

Pasii de la acest captiol sunt necesari de fiecare data cand creati o clasa noua. Nu este
singura metoda de a crea o clasa, dar e cea mai usoara.

1. Dati File-> New -> Class



= Mew Java Class L@g

Java Class
Create a new Java class. @

Source folder: HelloWorld/src

Package: ro.utcluj.poo.labol

[“IEnclosing type: Browse..
Modifiers: @ public ) package private protected
[[abstract [[final static
Superclass: javalang.Object
Interfaces: Add...
Remove

‘Which method stubs waquld you like to create?
c static void main(String[] args)
[“] constructors from superclass
[#lInherited abstract methods

Do you want to add comments? (Configure templates and default value here)
[7] Generate comments

@ [ Finish ] [ Cancel

2. Dati Finish si adaugati linile de cod, ca mai jos:

package ro.utcluj.poo.lab8l;

1
2
3 public class Main {
= ublic String getMessage()]
5 return "";
&
7E public static woid main(String[] args) {
g8 Jf TODO Auto-generated method stub
g [:%_ System.out.println{"Hello world!");
18
11
12}
13

7.3 Rularea unui program

Dupa ce ati scris, salvati si apasati pe Run (butonul verde, cu triunghi alb)



< Java - HelloWorld/sre/ro/uteluj/poo,lab01/Main java - Eclipse

File | Edit Source Refactor MNavigate Search Project Run Window Help
Tar e @iPMeE IRt Q- RIH GO AL

[ package Explorer i2 = B | [J] Mainjava 2

= <§> < 1 package ro.utcluj.poo.label;

4 =¥ Helloworld

2

3 public class Main {

In partea de jos a ferestrei se observa consola:
ef main(String[])

P » 1 [a 1 G

& console & = B8

X% | &EEEFE a0~
<terminated= Main [Java Application] C:\Program Files\Java\jre1l.8.0_20\bin\javaw.exe (Oct 2, 2014, 11:16:17 AM
Hello world! -

} 4 [}

Writable Smart Insert 7:44

7.4 Adaugaera de teste

Testarea software este o parte vitala in dezvoltarea oricarei aplicatii. Vom insista mai
incolo asupra ei. Deocamdata trebuie sa va asigurati ca infrastructura merge.

1. Faceti click dreapta pe Main.java, din Package Explorer.
Alegeti TestNG -> Create TestNG class

Dati next:



New TestNG class

Specify additional information about the test class.

\HeIIoWorId\tesﬂ

ro.utcluj.poo.lab0l

Class name: MainTest

Source foldey;

Browse...

Package name:

Annotations

[l @Beforemethod [“| @AfterMethod ] @DataProvider
[[] @BeforeClass  [C] @AfterClass

[[] @BeforeTest [l @afterTest

[] @BeforeSuite [] @afterSuite

XML suite file:

@ Next = Finish ] [ Cancel

Apoi faceti click pe Finish.
2. Navigati in MainTest.java

3. Faceti click pe x-ul rosu din dreptul liniei 3
B0 Q- WG I®O VO

8 [J] Mainjava @] MainTestjava &2

1 package ro.utcluj.poo.label;
W 3 import grg.testng.annotations.Test;
4

public class MainTest {
© 0Test

public woid () {

h

S W~

=

Dublu click pe Add TestNG library



package ro.utcluj.poo.label;

1
= o . ,
41 3 import [sy- =.annotations.Test;
lass path =iiAdd TestNG library e————

® Create class Test' in package 'org.testng.annotat
@ Create interface Test' in package 'org.testng.ann
@ Create annotation ‘Test' in package 'orgtestng.ar
@ Create enum Test' in package 'org.testng.annota

<«*Remove unused import
e T T e T

Toate sublinierile si bulinele rosii ar trebui sa dispara.

4. Scrieti urmatorul cod:

=

[J] Main,java [J] MainTestjava &2
1 package ro.utcluj.poo.lab8l;

= import org.mockito.Mock;
import org.mockito.Mockito;
import static org.mockito.Mockitofnnotations.™®;
import org.testng.annoctations.Test;
public class MainTest {
oMock
Main main;
@Test
public woid () {
initMocks(this);
Mockito.when(main.getMessage()).thenReturn( "WORKING! ")}
14 System.out.println({main.getMessage());

= WP R

woca
1 1

= e
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7.5 Rularea testelor:
Avand fisierul de test deschis, dati din nou run si observati consola:



[TestNG] Running:
C:\Users\visoft\AppData\local\Temp\testng-eclipse--486854403 \testng-customsuite. xml

¢_WORKING! 7

PASSED: T

Default test
Tests run: 1, Failures: @, Skips: @

[TestNG] Time taken by org.testng.reporters.JUnitReportReporterfié26b2d4a: 16 ms
[TestnNG] Time taken by org.testng.reporters.SuiteHTMLReporter@?3as8dfcc: 31 ms
[TestNG] Time taken by org.testng.reporters.EmailableReporter2@&f2boS8e: 4 ms
[TestnG] Time taken by [FailedReporter passed=@ failed=@ skipped=28]: @ ms
[TestNG] Time taken by org.testng.reporters.jg.Mainf@aec6354: 29 ms

[TestNG] Time taken by org.testng.reporters.XMLReporterfc2elf26: 4 ms

8 Evaluare

Tema se considera incheiata cand:
1. Programul ruleaza si apare ,,Hello World”
2. Testele ruleaza si apare mesajul ,,WORKING”

9 Instrumente ajutatoare:

http://wiki.eclipse.org/Eclipse/Installation
http://testng.org/doc/download.html
http://eclipsesource.com/blogs/2011/09/19/effective-mockito-part-1/
Arhivator: 7-zip: http://lwww.7-zip.org/



